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In this chapter, you’ll learn about putting the 

finishing touches on a presentation:

◆ Add within-slide animations, incoming 

slide transitions, and action buttons

◆ Make minor edits to movies you’ve placed 

on slides

◆ Rearrange slides to match their final order, 

as well as delete and hide slides

◆ Rehearse the presentation while recording 

the time spent on each slide and on the 

total presentation

◆ Print notes, handouts, and other material 

you’ll need for the presentation

◆ Save the presentation in other formats 

(such as PDF) and package its contents 

on a CD or DVD

◆ Present the slide show in person or broad-

cast it over the Internet

✔ Tip

■ To run a finished presentation, follow the 

steps in “Previewing the Slide Show” in 

Chapter 14.

Wrapping Up  
a Presentation
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Animating Objects and Text
To add motion to a presentation, you can 

animate any object on a slide, such as a text 

block, picture, chart, or SmartArt object. 

You can choose animation effects from the 

Animation or Add Animation gallery. You can 

fine-tune an effect by choosing commands 

from the Animations tab or by opening the 

Animation Pane. Any slide can contain mul-

tiple animated objects. You can even assign 

multiple animations to the same object.

To assign an animation to an object:

1. In Normal view, select the object on the 

current slide that you want to animate. 

Switch to the Animations tab.

2. Choose an effect from the Animation 

gallery (Figure 15.1, below).

As you hover the cursor over an effect, an 

animation preview appears on the slide. 

After you pick an effect, a number appears 

beside the object that shows the order in 

which the effect will play (Figure 15.2).

3. Optional: To add another effect to the 

object, choose it from the Add Animation 

gallery in the Advanced Animation group.

Figure 15.2 Each animation is numbered to show 
the sequence in which it will play.

Number

More

Figure 15.1 View different animation effects by clicking the scroll arrows or click More to see the entire 
animation gallery.
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To set options for an effect:

1. In Normal view, switch to the Animations 

tab. On the slide, select the number of the 

animation effect that you want to modify.

2. Do any of the following:

▲ Choose an option from the Effect 

Options menu (Figure 15.3).

▲ Click the dialog box launcher icon at 

the bottom of the Animation group 

and set options in the dialog box that 

appears (Figure 15.4).

▲ Click the Animation Pane icon in the 

Advanced Animation group. In the 

pane, select the animation that you 

want to modify. Then choose an option 

from the Effect Options menu, click 

the Effect Options dialog box launcher, 

or choose Effect Options from the 

drop-down menu to the right of the 

object name.

✔ Tips

■ Even information in the footer, such as 

the slide number, can be animated.

■ To view additional effects, choose a More… 

command from the Animation gallery or 

Add Animation drop-down menu. 

■ To set an effect for multiple objects that 

will all play simultaneously, select all of 

the objects and then choose the effect. 

■ To apply one object’s animations to 

another object, select the object with the 

animation you want to copy, click the 

Animation Painter icon in the Advanced 

Animation group, and then click the tar-

get object.

continues on next page

Figure 15.3 When 
available, effect options 
differ for each effect.

Figure 15.4 You set options for a selected effect in 
an effect-specific dialog box. This is where you can 
associate a sound with an effect, for example.

  



ptg

Chapter 15

266

A
n

i
m

a
t

i
n

g
 O

b
j
e

c
t

s
 a

n
d

 T
e

x
t

■ When animating a complex object com-

posed of multiple elements, such as a 

SmartArt graphic or chart, you can animate 

it as though it were a single object, one 

element or item type at a time, and so on.

■ To replace one animation with another, 

select the effect step for the object in the 

Animation Pane and choose a replacement 

effect from the Animation gallery.

■ You can view a slide’s animations by click-

ing the Preview icon in the Preview group 

or by clicking Play in the Animation Pane.

■ To change the order in which animations 

will play, open the Animation Pane, select 

the effect that you want to move, and then 

do any of the following: 

▲ Drag the effect up or down to a new 

position in the list.

▲ Click a Re-Order icon at the bottom of 

the Animation Pane (Figure 15.5). 

▲ Click a Reorder Animation icon (Move 

Earlier or Move Later) in the Timing 

group (Figure 15.6).

■ To remove an animation from a selected 

object, do one of the following:

▲ Select None in the Animation gallery. 

▲ Choose Remove from the effect’s drop-

down menu in the Animation Pane 

(Figure 15.7).

▲ Select the effect in the Animation Pane 

or select the effect’s number on the slide 

and press D.

■ Don’t overuse animations. A few can draw 

attention to key elements on important 

slides; too many can turn a presentation 

into a carnival sideshow.

Figure 15.5 You can click a Re-Order icon at the 
bottom of the Animation Pane to move a selected 
animation step to a different position.

Figure 15.6 Or you can click the Move Earlier or Move 
Later icon in the Timing group. Each click moves the 
effect one step up or down in the animation list.

Figure 15.7 To remove an effect, you can 
select it in the Animation Pane and choose 
Remove from the effect’s drop-down menu.
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Editing Movies
Office 2010 provides tools for editing videos. 

When you select a movie on the current slide, 

the Video Tools contextual tab appears. You 

can choose new settings from its Format and 

Playback tabs. 

Format tab tools
Using commands on the Format tab of the 

Video Tools contextual tab, you can perform 

the following edits on a selected movie clip:

◆ Correct brightness/contrast. Choose a 

brightness/contrast thumbnail from the 

Corrections gallery in the Adjust group 

(Figure 15.8). For more precise settings, 

choose Video Corrections Options from 

the bottom of the gallery menu.

◆ Recolor movies. To display the video in 

grayscale (shades of gray) or with an overall 

color cast, choose a thumbnail from the 

Color gallery in the Adjust group. Choose 

More Variations if you want to use a color 

that isn’t shown.

◆ Set a poster frame. A poster frame is an 

image used to represent the movie when 

it’s not playing. To select a movie frame, 

advance the movie to the frame and choose 

Current Frame from the Poster Frame 

drop-down menu in the Adjust group 

(Figure 15.9). If you prefer, you can select 

a picture from your hard disk to serve as 

the poster frame.

◆ Add a border. If you want to surround the 

movie with a border, choose settings from 

the Video Border drop-down menu in the 

Video Styles group. Alternatively, you can 

click the Format Video dialog box launcher 

(found at the bottom of the Video Styles 

group) and select settings from the Border 

Color and Border Style categories.

Figure 15.8 You can alter the brightness/contrast and 
color cast of a movie by choosing thumbnails from the 
Corrections and Color galleries.

Figure 15.9 You can set a poster frame for a video.
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◆ Apply object formatting. You can add a 

fancy frame or alter the shape of a video 

clip by choosing commands from the Video 

Styles group (Figure 15.10).

◆ Resize movies. You can resize any movie 

frame by doing any of the following:

▲ Click a corner and drag.

▲ Type new numbers or click the arrows 

in the Video Height and Video Width 

boxes in the Size group (Figure 15.11).

▲ Click the dialog box launcher in the Size 

group (Figure 15.11) to enter specific 

dimensions or scaling numbers.

◆ Reset formatting. To remove all applied 

formatting changes, click Reset Design in 

the Adjust group (see Figure 15.8).

✔ Tip

■ Other than selecting a poster frame to 

ensure that a consistent image appears 

when the slide is first presented, it’s unlikely 

that you’ll use many of the commands on 

the Format tab to modify the appearance 

of your movies.

Playback tab tools
Using commands on the Playback tab of the 

Video Tools contextual tab, you can specify 

how a selected movie clip will play during the 

presentation:

◆ Trim videos. Click the Trim Video com-

mand in the Editing group to remove 

unwanted frames from the start or end 

of a video clip. In the Trim Video dialog 

box (Figure 15.12), drag the green start 

marker and/or the red end marker to new 

positions, and then click OK.

Video Height

Video Width

Dialog box 
launcher

Figure 15.11 You can set a new 
size for a movie by entering 
dimensions in the Size group.

Start End

Figure 15.12 Drag the start and/or end markers to 
new positions to cut out unwanted frames. As you 
drag, a live preview of the movie is shown.

Figure 15.10 To add a stylized frame or border to a 
movie, choose options from the Video Styles group.
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◆ Add/remove bookmarks. You can mark 

key points in a movie by assigning book-

marks to them. Bookmarks enable you to 

jump directly to that frame or can be used 

to trigger animations. 

▲ To add a bookmark, move the movie 

slider to the desired spot and then 

click the Add Bookmark icon in the 

Bookmarks group (Figure 15.13). 

▲ To delete an unwanted bookmark, 

select its bookmark icon on the movie 

slider and click Remove Bookmark.

◆ Fade in or out. You can instruct a movie 

to smoothly fade in or out by entering 

numbers (in whole and fractional seconds) 

in the Fade Duration boxes in the Editing 

group (Figure 15.14).

◆ Other playback options. The self-

explanatory tools in the Video Options 

group (Figure 15.15) are used to set key 

playback behaviors, such as audio volume, 

whether the clip will play automatically or 

wait for a mouse click, and so on.

✔ Tips

■ You can remove inserted videos that you 

no longer want. Select the video on the 

slide and press D or d.

■ To reduce the size of all embedded videos 

in a presentation, switch to the Backstage 

by clicking the File tab. Select the Info 

category and choose a quality setting from 

the Compress Media drop-down menu. 

View the results by running the show. 

If you aren’t satisfied, you can undo or 

change the compression by revisiting the 

Compress Media command. 

Figure 15.13 Create or 
delete bookmarks by 
clicking icons in the 
Bookmarks group.

Embedded vs. Linked Videos

Normally, inserted movies are embedded

in the presentation. The video is saved 

with the PowerPoint file, ensuring that 

it will always be available whenever and 

wherever the show is presented. Another 

option is to link the movie to the presenta-

tion—using either a movie from a Web site 

or a file on disk. To play such a movie, you 

must have access to the Internet or to the 

file’s location, such as a flash drive or DVD.

To link a movie file, select a slide place-

holder, click the Insert tab, click the Video 

icon in the Media group, and choose Video 

from File or Video from Web Site. When 

choosing the latter, you will be asked to 

paste the “embed code” provided by the 

Web site.

Figure 15.14 You can apply a fade in or fade 
out to any movie clip.

Figure 15.15 Apply additional settings from the Video 
Options group.
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Organizing the Slides
In Slide Sorter view (Figure 15.16), you can 

rearrange the slides to match their final order. 

You can also delete unwanted slides, as well 

as hide ones you want to keep but won’t be 

using in the current presentation.

To organize the slides:

1. Switch to Slide Sorter view by clicking 

its icon in the Presentation Views group 

on the Views tab or at the bottom of the 

document window.

2. Adjust the magnification controls to clearly 

display the slide thumbnails. 

3. Do any of the following:

▲ To change a slide’s order in the show, 

drag its thumbnail to a new position.

▲ To delete a slide, right-click its thumb-

nail and choose Delete Slide from the 

context menu (Figure 15.17).

▲ To hide a slide, right-click its thumb-

nail and choose Hide Slide from the 

context menu. The slide number shows 

a slide’s hidden status (Figure 15.18). 

In Normal view, hidden slides’ thumb-

nails are fuzzy.

✔ Tips

■ If you need to modify a slide, double-click 

its thumbnail. The slide appears in Normal 

view, ready for editing.

■ You can play a slide’s animations in Slide 

Sorter view by clicking the animation 

indicator beneath the lower-left corner of 

the thumbnail (Figure 15.18).

■ You can also organize slides in Normal 

view. To change a slide’s position, drag its 

thumbnail to a new location in the list. 

To delete or hide a slide, right-click the 

thumbnail and choose Delete Slide or 

Hide Slide from the context menu.

Magnification controls

Figure 15.16 Slide Sorter view.

Play animations Hidden slide indicator

Figure 15.18 When a slide is hidden, 
its number is displayed with a slash.

Figure 15.17 Right-click 
a thumbnail to delete 
or hide a slide.
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Adding Transitions
A transition is an effect that appears when 

switching to a new slide during a slide show. 

You can use the same transition for every 

slide change, different transitions for different 

slides, or no transitions at all (when present-

ing real slides or using an overhead projector, 

for example). When setting transitions, note 

that they are applied to the current slide’s 

entrance—not its exit.

To specify a transition:

1. In Normal or Slide Sorter view, select the 

slide thumbnail to which you want to add 

a transition.

2. Click the Transitions tab.

3. Choose an effect from the Transition to 

This Slide gallery (Figure 15.19).

A live preview is presented for any transi-

tion over which you hover the cursor.

4. Optional: To change the direction of the 

effect, choose an option from the Effect 

Options menu (Figure 15.19).

Effect options are different for different 

effects.

5. Optional: To add a sound effect to the 

transition, choose one from the Sound 

menu in the Timing group (Figure 15.20). 

To change the length of the transition 

effect, enter a new Duration (in seconds).

6. Select an Advance Slide option to deter-

mine whether the slide will advance 

manually (under presenter control) or 

automatically (based on time).

7. Optional: To apply the transition to every 

slide in the presentation, click Apply To All.

Figure 15.20 You can set additional options in the 
Timing group.

Advance Slide optionsSound and speed settings

Apply the current settings to all slides

And What About Sections?

Although we’ve gotten along without them 

for 20+ years, PowerPoint 2010 now allows 

you to group your slides into logical sec-

tions. Because you can expand or collapse 

a section in Normal or Slide Sorter view, 

sections are especially useful for focusing 

on specific parts of a large presentation.

To insert a section, switch to the Home 

tab, select the slide that will be the first 

one in the new section, and choose Add 

Section from the Section icon in the Slides 

group. To name the section, click its bar 

and choose Rename Section from the 

Section icon.

You can collapse or expand a section by 

clicking the triangle that precedes the sec-

tion name. To simultaneously collapse or 

expand all sections, choose the appropri-

ate command from the Section icon’s 

drop-down menu.

Figure 15.19 Select a transition effect from the gallery.

Effect Options
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✔ Tips

■ To view transitions in Normal or Slide 

Sorter view, click the Preview button in 

the Preview group.

■ Transitions can be skipped if you won’t be 

presenting on a computer.

■ To change a transition effect and options 

for a slide, select the slide and select new 

settings from the Transitions tab (see 

Figures 15.19 and 15.20).

■ To remove a transition from a selected slide, 

select the None transition (see Figure 15.19). 

To remove transitions from all slides, set 

any slide’s transition to None and then 

click Apply to All. 
Figure 15.21 On the Mouse Click or Mouse Over tab, 
specify a button action and click OK.

Adding Action Buttons

An action button is a shape you can place 

on a slide that performs a function when 

clicked, such as returning to the first slide, 

playing a sound effect, or launching an 

application. 

To add an action button to a slide, switch 

to Normal view, click the Insert or Home 

tab, and choose a button from the Action 

Buttons section of the Shapes gallery. Click 

and drag to draw the button on the slide. 

(To keep the button proportional to its 

original dimensions, press s as you 

drag.) Like other objects, you can move, 

resize, or format an action button.

In the Action Settings dialog box (Figure 

15.21, above), specify the action you want 

the button to perform in response to a 

mouse click or mouse over (moving the 

mouse over the button). Close the Action 

Settings dialog box by clicking OK.
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Rehearsing a Presentation
You’ll want to rehearse your presentation 

before giving it to an audience. In addition to 

helping prepare what you’ll say for each slide, 

a rehearsal can record the time spent per slide 

and on the total presentation. This serves two 

purposes. First, by reviewing slide timings, you 

can determine if you’re spending too much or 

too little time on some slides or the presenta-

tion. Second, if the presentation will run in 

kiosk mode, timings can be used to automati-

cally advance slides.

To rehearse slide timings:

1. On the Slide Show tab, click Rehearse 

Timings in the Set Up group (Figure 15.22).

The slide show begins.

2. Present the show as you intend to give it 

to your audience, advancing through the 

slides by clicking the mouse, pressing a 

keyboard shortcut (see “Previewing the 

Slide Show” in Chapter 14), or clicking the 

Next button on the Recording toolbar 

(Figure 15.23).

As you switch slides, PowerPoint notes 

the amount of time spent on each one.

3. During the rehearsal, you can also use the 

Rehearsal toolbar as follows:

▲ Click the Pause button if you need to 

take a break. Click Pause again when 

you’re ready to continue.

▲ To restart the timing for the current 

slide, click the Repeat button.

4. When the show ends, a dialog box displays 

the total time and asks if you’d like to save 

the slide timings (Figure 15.24). Click Yes 

to save or No if you prefer not to save the 

timings.

✔ Tip

■ To replay a presentation using the saved 

timings, switch to the Slide Show tab, click 

the Use Timings check box (Figure 15.22), 

and click From Beginning in the Start Slide 

Show group. The slide show will play 

and automatically advance through the 

animations and slides using the saved 

timings.

Pause RepeatNext

Time for current slide Total time

Figure 15.23 Use the Recording toolbar 
to view slide timings, pause the show, or 
perform the next action.

Figure 15.22 Click Rehearse Timings to record the time 
you spend on each slide.

Figure 15.24 If the rehearsal went well, you can save 
the slide timings for use during the presentation.
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Printing Notes and 
Handouts
In preparation for the presentation, you can 

print your notes and audience handouts.

To print notes:

1. Click the File tab to go to the Backstage. 

Select the Print category.

A print preview (Figure 15.25) allows you 

to see the output prior to routing it to your 

printer.

2. Choose a printer from the Printer drop-

down menu. 

If your printer isn’t shown, choose Add 

Printer.

3. Using the following drop-down menus in 

the Settings section, enter these settings:

▲ Menu 1. Specify the slides you want to 

include in the printout, such as Print 

All Slides.

▲ Menu 2. Choose Notes Pages.

▲ Menu 5. Choose an orientation (por-

trait or landscape) for the printout.

▲ Menu 6. Indicate whether the notes 

should be printed in shades of gray 

(grayscale), black-and-white, or color.

4. To review the slides and notes as they’ll 

print, click the page controls beneath the 

preview (Figure 15.25).

5. Optional: To edit the header or footer, click 

Edit Header & Footer. Make any desired 

changes on the Notes and Handouts tab 

of the Header and Footer dialog box that 

appears (Figure 15.26).

6. In the Print section, specify the number of 

copies to print.

7. Click the Print button. 

When you print, the notes print one slide 

per page.

Figure 15.25 All print settings can be chosen and their 
effects previewed in the Backstage.

PreviewPrint options

MagnificationPage controls

Figure 15.26 By default, only the slide number is 
included as footer data on a notes page. However, 
you can customize the header and footer, if you wish.
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To print audience handouts:

◆ Perform the “To print notes” task list. In 

Step 3, however, choose a Handouts layout 

(Figure 15.27) from the second drop-down 

menu rather than choosing Notes page.

✔ Tips

■ Choose Full Page Slides from the second 

drop-down menu to print an enlarged ver-

sion of each slide (one slide per page).

■ In a printed handout, the 3 Slides option 

provides lines on which the audience can 

write notes (Figure 15.27).

■ It can be helpful to choose Outline from 

the second drop-down menu. The printout 

(Figure 15.28) provides a slide-by-slide 

listing of the text contained on each slide.

Figure 15.27 Choose a Handouts layout from this 
drop-down menu.

Figure 15.28 Choose Outline to print slide text in 
outline form.
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Saving a Presentation In 
Other Formats
If the slide show will be presented or needs 

to be delivered to recipients in a form other 

than as a PowerPoint 2010 presentation, you 

can generate an additional copy of it in the 

necessary format. In PowerPoint 2010, all of 

the essential commands can be found in the 

Share section of the Backstage. From this 

area, you can save or convert the current pre-

sentation to a variety of popular formats. In 

this section, you’ll learn to save presentations 

in alternative PowerPoint formats, convert a 

presentation to a PDF file, package a presen-

tation for distribution on CD, and generate a 

PowerPoint video from a presentation.

To save a presentation in an alternative 
PowerPoint format:

1. In the Share section of the Backstage, select 

Change File Type. 

A file type list appears (Figure 15.29).

2. Select an output file type from the Change 

File Type list.

A Save As dialog box appears (Figure 15.30). 

The correct file type is preselected in the 

Save as type list.

3. Navigate to the drive and folder in which 

you will save the file, rename the file 

(optional), and click Save.

✔ Tips

■ You can also save in an alternate format by 

selecting Save As in the Backstage. When 

the Save As dialog box appears, simply 

select the desired file type from the Save 

as type list (Figure 15.30).

■ If an intended recipient has an older version 

of PowerPoint, choose PowerPoint 97-2000 

Presentation as the output file type.

Figure 15.29 Select an output file type from this list.

Figure 15.30 Select a location in which to save the new 
file and then click Save.

Save As type list
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To save a presentation as an Adobe 
Reader (PDF) file:

1. In the Share section of the Backstage, 

select Create PDF/XPS document. 

2. Click the Create a PDF/XPS button. 

The Publish as PDF or XPS dialog box 

appears (Figure 15.31).

3. Optional: If you want to specify a subset 

of slides to include or publish handouts, 

notes, or an outline view of the presenta-

tion, click the Options button and change 

the settings in the Options dialog box that 

appears.

4. At the bottom of the Publish as PDF or 

XPS dialog box, specify whether to 

generate a Standard or Minimum size 

(compressed, lower resolution) file by 

clicking the appropriate radio button.

5. Navigate to the drive and folder in which 

you will save the file, rename the file 

(optional), and click Publish to create the 

PDF file.

The resulting PDF file can be viewed in 

Adobe Reader, Apple's Preview, and simi-

lar utilities.

✔ Tip

■ If you intend to email the PDF file, you can 

streamline the process by selecting Send 

Using E-mail in the Share section of the 

Backstage and clicking the Send as PDF 

button (Figure 15.32). Similarly, if you 

want to share the actual presentation via 

email (enabling it to be edited and viewed 

by the recipient in a current version of 

PowerPoint), click Send as Attachment.

Figure 15.31 Use this modified file output dialog box 
(Windows 7) to specify a name, disk location, and 
quality for the PDF file.

Figure 15.32 Two popular Send Using E-mail options 
are Send as PDF and Send as Attachment.
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To package a presentation for 
distribution on CD or DVD:

1. In the Share section of the Backstage, 

select Package Presentation for CD and 

click the Package for CD button.

The Package for CD dialog box appears 

(Figure 15.33).

2. Type a short name for the CD/DVD in the 

Name the CD text box.

3. If you want to add other presentations to 

the same CD/DVD, click Add. Select the 

additional presentation filename(s) from 

the Add Files dialog box and click Add.

The presentation names are added to 

the list in the Package for CD dialog box. 

You can change their order by selecting a 

filename and clicking the up- or down-

arrow button.

4. Optional: If you want to password-protect 

a presentation to prevent it from being 

opened or modified by unauthorized users, 

click the Options button and make the 

necessary changes in the Options dialog 

box (Figure 15.34).

5. Click the appropriate Copy button as 

described below. Note that if you intend to 

create a DVD rather than a CD, you must

use Copy to Folder and then create the DVD 

using separate DVD burning software.

▲ Copy to CD. Insert a blank CD into 

your CD or DVD burner. In the dialog 

box that appears, click Yes or No to 

include linked files on the CD. Office 

burns the selected presentation(s) 

onto the CD.

A recipient can view the presentations 

with PowerPoint or PowerPoint Viewer 

(2007 or higher). Instructions for down-

 loading and installing PowerPoint 

Viewer are provided on the CD.

Figure 15.33 The current presentation is automatically 
included in the Files to be copied list. Add other 
presentations (if desired), set options, and copy the 
files to a CD or a folder.

Figure 15.34 In the Options dialog box, you can add 
password-protection to the copied presentations.

  



ptg

Microsoft PowerPoint: Wrapping Up a Presentation

279

S
a

v
i
n

g
 a

 P
r

e
s

e
n

t
a

t
i
o

n
 i

n
 O

t
h

e
r

 F
o

r
m

a
t

s

▲ Copy to Folder. Click this button to 

copy the presentations and supporting 

files to disk for later burning to CD or 

DVD. If desired, you can set the same 

options as described previously by 

clicking the Options button. In the Copy 

to Folder dialog box (Figure 15.35), 

select an output location by clicking 

Browse, name the presentation folder, 

and click OK. 

✔ Tips

■ A presentation CD contains normal cop-

ies of your PowerPoint files. If you don’t 

want to allow these files to be opened or 

edited in PowerPoint, set password(s) in 

the Options dialog box (see Figure 15.34).

■ If you want to avoid the requirement that 

recipients have PowerPoint or PowerPoint 

Viewer on their computer, you may prefer 

to create a Windows Media Video (WMV) 

of the presentation as described below.

To create a video from a presentation:

1. Optional: Record the slide timings (Rehearse 

Timings on the Slide Show tab) or timings 

and narrations (Record Slide Show on the 

Slide Show tab). These elements can be 

incorporated into the video.

2. In the Share section of the Backstage, 

select Create a Video.

Create a Video options appear on the right 

side of the page (Figure 15.36).

3. From the first drop-down menu, choose an 

output size/quality setting.

4. From the second drop-down menu, you 

can elect to use recorded timings and nar-

rations or a default duration per slide.

continues on next page

Figure 15.35 Specify a disk location and new folder 
name, and then click OK.

Figure 15.36 Set options for the video and click OK.
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5. In the Seconds to spend on each slide box, 

enter a default duration to use for display-

ing each slide.

If you chose Don’t Use Recorded Timings 

and Narrations in Step 4, this timing will 

be applied to all slides in the presentation. 

If you chose Use Recorded Timings and 

Narrations in Step 4, this timing will be 

applied to every slide for which a timing 

hasn’t been recorded.

6. Click the Create Video button.

A Save As dialog box appears (Figure 15.37).

7. Name the output file, select a disk and 

folder in which to save it, and click Save.

A progress bar appears in PowerPoint’s 

status area, enabling you to track the 

video-creation process (Figure 15.38). 

At its conclusion, the WMV file is saved 

to disk. The video can be played on a PC 

using Windows Media Player and similar 

programs, as well as on other devices that 

can play WMV videos.

✔ Tip

■ Before running, saving, or exporting a 

presentation, it’s a good idea to review the 

settings in the Set Up Show dialog box. 

Options enable you to create a self-running 

presentation (kiosk mode) and specify 

whether recorded timings will automati-

cally advance slides. To open the dialog box, 

click the Set Up Slide Show icon in the Set 

Up group of the Slide Show tab.

Figure 15.38 A progress bar appears in the status 
area. If necessary, you can click Cancel to halt the 
video-creation process.

Cancel

Figure 15.37 Name the file, select a location in which 
to save it, and click Save.
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Delivering the Presentation
Of course, delivering the presentation is the 

ultimate goal of your work in PowerPoint. In 

this final section, you’ll learn how to present 

a show in person or broadcast it over the Web.

Delivering an in-person show
The following steps show how the majority of 

slide shows are presented to an audience.

To deliver an in-person presentation:

1. Optional: To begin the show with a slide 

other than the first, select or switch to 

that slide in Normal, Slide Sorter, or Notes 

Page view.

2. On the Slide Show tab, set options in 

the Set Up (Figure 15.39) and Monitors 

groups as follows:

▲ Hide Slide. Select each slide that you 

want to skip and click Hide Slide.

▲ Use Presenter View. If you’ll be using 

multiple monitors to present the show, 

enable this option in the Monitors group.

▲ Set Up Slide Show. Click this icon to 

open the Set Up Show dialog box 

(Figure 15.40). You can set these 

primary show options here or click 

check boxes in the Set Up and Monitors 

groups.

3. Do one of the following:

▲ To run the show starting with the first 

slide, press 5.

▲ To run the show starting with the cur-

rent slide, press s5.

▲ On the Slide Show tab, click the From 

Beginning or From Current Slide icon 

in the Start Slide Show group.

The presentation begins.

continues on next page

Figure 15.39 Before presenting the show, make sure 
these settings are correct.

Figure 15.40 The most important pre-show settings 
can be managed in the Set Up Show dialog box.
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4. Do any of the following:

▲ If Use Timings is checked in the Set Up 

group (see Figure 15.39), the show will 

play automatically from start to finish.

▲ To manually step forward through the 

slides and within-slide animations (if 

any), click the mouse or press n, e, 

Y, z, S, or Z.

▲ To move backward through the slides 

and within-slide animations (if any), 

press p, U, B, A, or W.

▲ To end the show, press q.

Broadcasting a slide show
In PowerPoint 2010, you can broadcast a 

presentation over the Internet that invited 

audience members can view with a browser 

(Figure 15.41). PowerPoint provides two 

methods for broadcasting a presentation:

◆ To broadcast over a network, the company 

must use SharePoint Services 4.

◆ To broadcast over the Internet using the 

PowerPoint Broadcast Service, you must 

have a Windows Live or Hotmail account. 

Note the following limitations of a broadcast:

◆ The PowerPoint presentation file must be 

20 MB or smaller.

◆ Audience members must use Internet 

Explorer, Firefox, or Safari to view the 

presentation. 

◆ Although most animations will play 

correctly, all assigned transitions will be 

shown as a Fade. 

◆ Audio (sound effects or narration) will not 

be transmitted.

In this section, you’ll learn how to perform a 

Web broadcast. For information on broad-

casting via SharePoint, contact your network 

administrator.

Figure 15.41 The audience can view the broadcast 
in their browser. New slides and animations appear 
based on individual slide timings or the presenter’s 
mouse clicks.

View full screen
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To broadcast a slide show using the 
PowerPoint Broadcast Service:

1. Open the PowerPoint presentation that 

you intend to broadcast.

2. On the Slide Show tab, set options for the 

show as instructed in Step 2 of the previ-

ous step list.

3. Click Broadcast Slide Show in the Start 

Slide Show group.

The Broadcast Slide Show dialog box 

appears (Figure 15.42).

4. Click the Start Broadcast button.

5. If a Windows Security dialog box appears 

(Figure 15.43), enter your Windows Live 

or Hotmail address and password. Click 

OK to continue.

6. Office connects to the PowerPoint 

Broadcast Service and prepares the show 

for broadcast. A link to the Web presenta-

tion appears (Figure 15.44). Do any of the 

following:

▲ Copy Link. Click Copy Link or press 

cC to copy the selected URL to the 

Clipboard for pasting into an email 

or an instant message. Instruct the 

recipient to paste the URL into their 

browser’s address box. (If it is received 

as link text, they can just click it.)

▲ Send in Email. Click Send in Email to 

generate an email message containing 

the link. Address the message, edit the 

message text as desired, and click Send.

7. When audience members have the pre-

sentation URL opened in their browser, 

click Start Slide Show (Figure 15.44).

The slide show begins (see Figure 15.41).

continues on next page

Figure 15.42 The Broadcast Slide Show dialog box.

Figure 15.44 Communicate the show’s URL to your 
audience.

Figure 15.43 Enter your Windows Live or 
Hotmail sign-in information and click OK.
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8. When the presentation is finished, click 

the mouse button or press q to return 

to the PowerPoint window. Click the End 

Broadcast button beneath the Ribbon 

(Figure 15.45, below) and then confirm.

✔ Tip

■ When contacting the audience prior to 

beginning a broadcast, you may want 

to ask them to confirm they’re ready by 

clicking Reply in response to your email 

announcement. 

Figure 15.45 When the show is finished, click End Broadcast (found immediately beneath the Ribbon).
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